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If you have any questions which are not answered here, please don't hesitate to contact us.

Formatting

In order to publish your book via our web site your manuscript must be formatted in a way we can accept. 
This enables us to reduce costs, a saving we pass on to you.

We give you a choice of font and book size and show you how to easily adjust you headers, footers, page 
margins and page numbering before uploading.

Your manuscript must be in Word For Windows™ (for PC or Mac). It must exist as a single document on your 
hard drive.

The approved manuscript template file for the word processor and application you use Your 
manuscript must be submitted in an approved manuscript template file. This file is one file laid out in one of 
the 3 acceptable size formats in portrait orientation. Please do not change the template or submit more than 
one template file (i.e. do not separate chapters or sections into several files.)
Separate your chapters by inserting a page break. To print your book, we need to see how your manuscript 
flows from the title page through the text chapters to the end.

Accepted Platforms and Applications
PC:
MS Word, WordPerfect /Adobe PDF
MAC:
MS Word, WordPerfect / AppleWorks / Adobe PDF

We also accept Quark™ or Adobe PageMaker™ files. Important note: If you are sending us Quark™ or 
Pagemaker™ files, they should be put into a Zip file and must include all fonts and pictures used in the file.

Basic Text Formatting Rules
There are some standard rules concerning layout of text, listed below are some useful guides which you may 
wish to follow. However if do not want to follow convention you do not have to. The book is yours and you 
can format the text the way you want!
Be Consistent
Be consistent in your use of each element in your book. The title, subtitle, author name(s), etc. should be 
used and spelled exactly the same way every time they appear in your manuscript. Spelling
Be absolutely consistent in your spelling and capitalisation. We will not spell check your manuscript.
Chapter Breaks
Each chapter should end with a simple page break. This will let us know where the end of the section occurs.
Page Breaks
Please do not insert page breaks at the end of what you feel is a "page" in the body text. Since your 
manuscript is a word processing document, the length of the pages may not be the same when the book is 
printed as many word processing documents have a tendency to reflow when moved from computer to 
computer. (As a rule does not happen when saved as a Postscript file or PDF file). If you are "pausing" 
between paragraphs (ideas) within a chapter, please note this using a double line space.
Punctuation
Make sure your text wraps. Do not manually hyphenate words. Let your word processing application do it for 
you automatically. To indent paragraphs, use a tab character not spaces. Use only one space after all 
punctuation. View the number of spaces, hard carriage returns and other invisibles by clicking the paragraph 
symbol () on the toolbar at the top.
Punctuate carefully. Punctuation almost always falls within quotation marks.
Check your style guide and have your manuscript copy edited and proof read.
To separate periods of time or numbers, use en dashes (the longer dash). Dashes, ellipses and other special 
characters are found under the Insert menu under Symbol/Special Characters. Use em dashes (the longest 
dash) or ellipses (...) to separate thoughts or clauses within a sentence. To separate words use hyphens (-).
WORDS TYPED IN ALL CAPS should be limited, as they become difficult to read.
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The Special Characters list in your word processing application is where you will find smart quotes and other 
useful characters and symbols. Use them automatically by selecting them globally (for example in Word go in 
the Tools menu AutoCorrect/AutoFormat/Replace Straight Quotes with Smart Quotes, etc.
To emphasise text, use bold. 

Graphics

What is a graphic?
A Graphic is anything else that is not text. It can be large, a background texture, small a picture a piece of 
clip art or map.

Will you scan an image in for me?
Yes if required, please submit all images by Registered Mail and we will be happy to quote for this service. 

How do I embed a graphic?
Microsoft word:
Click on where you want to place and embed your graphic. Go to the Insert menu, click Picture and then 
select From file in the file name box, type the name of the file you want to embed, or click browse to select 
from a list.
Mac:
In navigation window, find and select the file you want to embed (when you create an embedded object, be 
sure the link to file check box is selected).

Accepted graphics formats
The file format of a graphic is the internal structure that a computer uses to save a graphic. Choosing the 
correct file format can directly effect the final output quality of the printed image.

Acceptable formats:
Tiff (.tif )- Tagged Image file - for raster images such as scans of photographs (half tones), pictures from 
digital cameras, images created in a digital painting programs. This is the standard file format for scanned 
images and for exporting grey-scale and colour images to other programs.
EPS (.eps)- Encapsulated PostScript vector images such as pie charts, bar graphs, and some clip art. 
Standard format for saving object-oriented graphic.

We do not accept:
.bmp as they cannot be easily sized. .gif files as they are a lower resolution format and will not print very 
well. .jpeg files, this is a compressed file format and decrease image quality.

What are the preferred resolutions for submitting graphics?
200 dpi is the preferred minimum resolution for all grey scale images including photographs. Line art, 
(images with out any shades of grey, i.e. a cartoon) and colour photographs should be scanned in at 300 dpi 
for optimum quality.

What size should I make the images?
Images should be submitted in their final form and size, as they will appear in your manuscript.

Privacy Statement

At the Fast-Print Network we respect your privacy. For full details of our privacy policy, click here.
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ISBN (International Standard Book Number)

ISBN is an international code assigned to a particular title and edition of a book published by a specific 
publisher.

Allocation of ISBNs is done by the International ISBN Agency in Berlin through the National Centre of a 
country.

The assigned ISBN is printed on the reverse of the title page and on the back of the cover. Example of an 
ISBN: ISBN 0-3399557-0-5 or ISBN 0 3399557 0 5 ISBN.

Structure
Every ISBN consists of ten digits, which is preceded by the letters ISBN printed in bold. The ten digit number 
is divided into four parts of variable length, each part being separated by a hyphen or space.
The four parts are:
Part I. Group Identifier. This part identifies the national, geographic or other similar grouping of publisher.
Part II. Publisher Identifier. This part identifies a particular publisher within a country or group.
Part III. Title Identifier. This part identifies a particular title or edition of a title published by the publisher.
Part IV. Check Digit. This is a single digit or alphabet X at the end of the ten digits of the ISBN. It is an 
automatic check by the system on the correctness of the ISBN.

ISBN 0 - 3399557 - 0 - 5
Group

Identifier   Publisher
Identifier   Title

Identifier   Check
Digit 

Application of ISBN
A separate ISBN must be assigned to the following:
1. Every title of a book, but NOT reprints or unchanged impression of the same book.
2. Every new edition of the same title, e.g. 2nd edition, revised edition etc.
3. Reprints of the same book produced by different publishers.
4. Books in different formats e.g. a hard back edition and a paper back edition.
5. Multi-volume works where an ISBN in assigned to individual volume in the set as well as to the whole set 
of the volumes.
6. Reprints to earlier titles not assigned ISBNs.
7. Collaborative publications. An ISBN is assigned to the publisher in change of distribution.
8. Imported books without ISBN sold or distributed by agents.
9. Loose- leaf publications.
ISBN should not be re-used
An assigned ISBN once allocated must NOT be re-used. Publisher should inform the National ISBN Centre 
of unused ISBN assigned numbers or when there is any change to the title where ISBN has been allocated.

Benefits to Publishers
Promotes and facilitates the ordering and acquisition of books published in the UK both at national and 
international level. Promotes sales of books published in the UK in local and international market. Appear as 
important elements in the bibliographic description of a publication in the national bibliographies, book trade 
directories, advertisements; publisher's catalogues and catalogue entries prepared by libraries and 
publishers. Used as serial number in the stock control for title published. Further strengthens the ownership 
of the books by publishers.

Request for ISBN
All book titles are eligible for an ISBN. ISBN should be requested before a book is printed. There is now a 
charge of £50 plus VAT for all new publishers registering with the ISBN agency for the first time. This initially 
gives you 10 ISBN numbers. The processing time for an ISBN allocation is 10 working days from receipt of 
correctly completed forms.

Further information can be obtained from the UK National ISBN Centre at the following address:
UK International Standard Book Numbering Agency,
Woolmead House West,
Bear Lane,
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Farnham,
Surrey GU9 7LG 
UK
Tel: Applications 01252 742590 (24 hours. Calls charged at 60p/min).
      Queries 020 7420 6008, Office Hours only (10am-1pm  2pm-4pm)
Fax: 01252 742526
E-mail: ISBN@whitaker.co.uk
Web: www.whitaker.co.uk/isbn.htm

Legal Deposit in the National Published Archive

What is legal deposit?
Legal deposit is the act of depositing published material in designated libraries or archives. Publishers and 
distributors in the United Kingdom and in Ireland have a legal obligation to deposit published material in the 
six legal deposit libraries, which collectively maintain the national published archive of the British lsles.
These are:
The British Library,
The Bodleian Library, Oxford.
The University Library, Cambridge,
The National Library of Scotland, Edinburgh,
The Library of Trinity College, Dublin,
The National Library of Wales, Aberystwyth.
Publishers are obliged to send one copy of each of their publications to the British Library. The other five 
libraries have the right to claim those publications from the publishers and distributors. In practice many 
publishers deposit their publications with all six libraries without waiting for a claim to be made.
The principle of legal deposit has been well established for almost four centuries and has great advantages 
for authors and publishers. Publications deposited with the libraries are made available to users in their 
reading rooms, are preserved for the benefit of future generations, and become part of the national heritage. 

What is it based on?
In the United Kingdom, the Copyright Act of 1911 and, in Ireland, the Copyright Act of 1963 (currently being 
replaced by similar provisions in the Copyright and Related Rights Bill of 1999), make it obligatory for 
publishers and distributors in the United Kingdom and Ireland to deposit their publications.

What is included?
All printed publications come within the scope of legal deposit. A code of practice exists in the United 
Kingdom for the deposit of non-printed publications, including microform and electronic media. In Ireland, the 
Copyright and Related Rights Bill of 1999 also proposes to extend legal deposit to electronic formats. 

How is information about Publications made available?
Publications are recorded in the online catalogues of the six legal deposit libraries, all of which are accessible 
on the World Wide Web and will remain essential research tools for generations to come. Most of the books 
and new serial titles are listed in the British National Bibliography (BNB), which is used by librarians and the 
book trade for stock selection. All the legal deposit libraries contribute to BNB, which is available in printed, 
CD-ROM and online formats and has a world-wide distribution. 

What is a Publisher?
Within the terms of the Copyright Acts, 'Publisher' is to be understood as anyone who issues or distributes 
publications to the public. 

What are Publishers required to deposit?
Items published and distributed in the United Kingdom and in Ireland are liable for deposit, as are items 
originally published elsewhere but distributed in the United Kingdom and Ireland. The requirement for deposit 
remains, irrespective of the place of publication or printing, the nature and size of the imprint or the extent of 
distribution. 

Where should Publications be sent?
Publications destined for the British Library (with the exception of newspapers) should be sent to:
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Legal Deposit Office,
The British Library,
Boston Spa, Wetherby,
West Yorkshire LS23 7BY
Tel: +44 (0)1937 546268 Monographs or 546267 Serials
Fax: +44(0)1937546176
E-Mail: legal-deposit-books@bl.uk  legal-deposit-serials@bl.uk
Web: www.bl.uk

Newspapers destined for the British Library should be sent to:
Newspaper Legal Deposit Office,
The British Library,
Unit 3,120 Colindale Avenue,
London NW9 5LF
Tel: +44 (0)207412 7382
Fax: +44 (0)207412 7390
E-Mail: legal-deposit-colindale@bl.uk
Web: www.bl.uk

The other five legal deposit libraries employ an agent to collect publications on their behalf. Publications and 
enquiries should be addressed to:
Copyright Libraries Agency,
100 Euston Street,
London NWI 2HQ
Tel: +44 (0)20 7388 5061
Fax: +44 (0)20 7383 3540
E-Mail: ats@cla.ac.uk
Web: www.llgc.org.uk/cla

Irish publishers should send material destined for the five libraries to:
Irish Copyright Agency,
c/o Trinity College Library,
College Street,
Dublin 2
Tel:+353 (0)1608 1021
Fax: +353 (0)1671 9003
E-Mail: lbryan@tcd.ie
Web: www.tcd.ie/Library 

 

Self-publishing

Fully Edited
Every Author needs an editor. Have your work edited before you send it to Fast-Print. Be sure it is in its final, 
publishable form. Once your manuscript is sent to Fast-Print any corrections made may incur additional 
costs.

Proof Read
The final version we receive of your edited manuscript should be proof read by several people who've never 
read it before. They catch mistakes and errors that you never will. 
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Uploading

What is the difference between, 'Book Title' and, 'Manuscript Name'?
Any reference to, 'Book Title' means the actual title of your book. Manuscript name refers to the name of the 
document that is your book. The two may be the same, though your document will have a file extension (if 
you are working on a PC), such as .doc (Word for Windows).
We differentiate between the two in order to ensure that when we recover your document after you have 
uploaded it, we can match author with manuscript.

What should be the format of my photograph or cover file?
Photographs must be in either .tif or .eps format at a resolution of at least 300 dpi. When asked for the name 
of your cover photograph or image, you must enter only the name; such as, mypicture.tif or mypicture.eps.

What is a Zip file?
A Zip file is a way of compressing a file or files into one smaller file, thus speeding up electronic transfer. The 
most common applications for zipping files are WinZip™ for the PC and Stuffit Expander™ for the Mac. 
These are both shareware applications and can be downloaded from our downloads page

How do I Zip my files?
Once WinZip is installed, we would recommend copying all the files you wish to compress into a new folder 
(which you can later delete). Select all the files (Ctrl+A). Right-click the selection and select, 'Add to zip' from 
the menu. Name the file and the path to where you would like to save it (e.g. C:\Temp\myzip.zip). Click, 'Add'. 
A new Zip file will be created at the path specified.
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